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Chapter 1

About this Guide

This Uset's Guide provides information on how to prepate custom Virtual Analyzer
images in the following topics:

OVA File Creation Using New Virtual Machine Images on page 2-1

OVA File Creation Using Converted Virtual Hard Disk Drives on page 3-1

Virtual Analyzer Image Preparation Tool on page 4-1
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Document Conventions

The documentation uses the following conventions:

TaBLE 1-1. Document Conventions

CONVENTION DESCRIPTION
UPPER CASE Acronyms, abbreviations, and names of certain
commands and keys on the keyboard
Bold Menus and menu commands, command buttons, tabs,
and options
Italics References to other documents
Monospace Sample command lines, program code, web URLs, file

names, and program output

Navigation > Path

The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

ﬁ’ Note

Configuration notes

Q Tip

Recommendations or suggestions

O Important
L.

Information regarding required or default configuration
settings and product limitations

ﬁ WARNING!

Critical actions and configuration options




About this Guide

Audience

This User Guide is intended for administrators who need to create custom sandbox
images for Virtual Analyzer. The document assumes a working knowledge of networks
and information security, including the following topics:

+  Deploying and administering Deep Discovery or TippingPoint products

+  Using Oracle VM VirtualBox™ or VMware™ products

Terminology
TERMINOLOGY DESCRIPTION
Open Virtual A ready-to-use software package (operating system with
Appliance (OVA) applications) that does not require additional configuration or
installation. Virtual Analyzer supports only image files in the Open
Virtual Appliance (OVA) format.
Sandbox image A template used to deploy sandbox instances in Virtual Analyzer.

A sandbox image includes an operating system, installed
software, and other settings necessary for that specific computing
environment.

Sandbox instance A single virtual machine based on a sandbox image.

Virtual Analyzer A secure virtual environment that manages and analyzes objects
submitted by integrated products and administrators. During

analysis, Virtual Analyzer rates the characteristics in context and
then assigns a risk level to the object based on the accumulated

ratings.
Virtual Analyzer A collection of utilities that execute and detect malware, and
Sensors record all behavior in Virtual Analyzer.
Virtual Machine A file format used in virtual machines like VMware Workstation or

Disk (*.vmdk) Oracle VM VirtualBox.







@y Renn

Chapter 2

OVA File Creation Using New Virtual
Machine Images

Learn how to create a Virtual Analyzer-supported OVA file in the following topics:

Downloading and Installing VirtualBox on page 2-5
Creating Virtual Machine Images on page 2-6
Moditying the Virtual Machine Environment on page 2-24

Reducing the Size of VirtualBox Disk Images on page 2-32

Exporting Virtual Machine Images to OVA Files on page 3-51
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Creating OVA Files Using New Virtual Machine
Images

Procedure
1. Prepare the operating system and required applications.
For details, see Required Software on page 2-2.
2. Download and install VirtualBox.
For details, see Downloading and Installing VirtualBox on page 2-5.
3. Create a virtual machine image.
For details, see Creating Virtual Machine Images on page 2-6.
4. Modify the environment of the virtual machine image.
For details, see Moditying the Virtual Machine Environment on page 2-24.
5. Reduce the size of the VirtualBox Disk Image.
For details, see Reducing the Size of VirtualBox Disk Images on page 2-32.
6. Export the virtual machine image to an OVA file.

For details, see Exporting Virtual Machine Images to OVA Files on page 3-51.

Required Software

The following software must be installed on the virtual machine to achieve satisfactory
detection results.
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TABLE 2-1. Required Applications

SOFTWARE DESscRIPTION
Operating system Virtual Analyzer supports the following operating systems:
Windows XP
Windows 7

Windows 8/8.1

Windows 10
+  Windows Server 2003/2003 R2
+  Windows Server 2008/2008 R2
+  Windows Server 2012/2012 R2

O Important
<«

- Package the installer as an ISO file.

- Verify that Windows is activated with a valid product
key.

«  Use a computer name that reflects your organizations'
naming scheme.

- Disable automatic updates.

+  Trend Micro recommends using the English version of
the listed operating systems.
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SOFTWARE

DESCRIPTION

Microsoft Office

Virtual Analyzer supports the following versions:
+ 2003 (32-bit)
« 2007 (32-bit)

« 2013 (32-bit and 64-bit)
« 2016 (32-bit and 64-bit)

(
(
- 2010 (32-bit and 64-bit)
(
(

S
o

ortant

Do not install Microsoft Office using Office Click-to-
Run, or a disk image obtained from Click-to-Run. Use
a MSI installer to install Microsoft Office. For details,
see What is Click-to-Run.

After installation, open all Microsoft Office applications
and verify that the main editing screen is displayed. If
any confirmation dialog or welcome screen displays,
make any selection to close the screen and display the
main editing screen.

Welcome to Microsoft Office 2010 =

Help Protect and Improve Microsoft Office _J&OfﬁE“e"

Use Recommended Settings

o ®) Tnstal important an Office, W Offerme and
Mierosoft software, check online for salutions to prablems, download fles to heip Microsoft diagnose system prablems, autamatically
update Office content, and help imprave Office

0 Install Updates Only

© Instal important and for Office, Windons and other Microsoft software. Offer me new optional Office and
Microsoft softnare,

o Don't make ch

%) Choosing this option o

Getmore information on how to turn these settings on and off
sent o Microsoft, is not used to denty or contact you.
fead our privacy statement,

Ficure 2-1. Help Protect and Improve Microsoft
Office

Verify that your license allows you to virtualize the
applications. For details, see https://support.office.com.

Disable automatic updates.

Enable macros. For details, see Enable or disable
macros in Office files



https://technet.microsoft.com/en-us/library/jj219427.aspx#WhatIs
https://support.office.com
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
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SOFTWARE DESCRIPTION

Adobe Reader Install the version of Adobe Reader that is most widely used in
your organization. To download the most current version of Adobe
Reader, go to http://www.adobe.com/downloads/.

If you do not install Adobe Reader, Virtual Analyzer:

Installs Adobe Reader 8, 9, and 11 on all Windows XP and
Windows Server 2003/2003 R2 images during importing.

+ Installs Adobe Reader 9, 11, and DC on all Windows 7 and
newer images during import.

Uses all versions during analysis.

WARNING!

This consumes additional computing resources.

+ Installs .NET Framework 3.5 or later if the operating system
is Windows XP or Windows Server 2003.

Configure Adobe Reader to manually check for and install
updates. For details, see https://helpx.adobe.com/acrobat/kb/
reader-acrobat-updater-settings.html.

O Important
<

Do not install VMware tools to avoid triggering the anti-virtual machine functions of some
malware.

Downloading and Installing VirtualBox

Procedure

1.  Download the latest version of VirtualBox from https://www.virtualbox.org

wiki/Downloads.



http://www.adobe.com/downloads/
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
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Note

The VirtualBox Open Source Edition is licensed under the GPL V2. The full text of
the license is available at http://www.gnu.org/licenses/old-licenses/gpl-2.0.html.

2. Configure the language settings using one of the following methods:
+  Install VirtualBox with English as the default language.

«  After installation, go to File > Prefetrences > Language and then select

English.

¢ VirtualBox - Preferences (7 |==a]
I@, General Language
@ Input Interface Languages

Defauft -
(&) update English (built-in) E

Bahasa Indonesia 1

Lal 4

@ — Catala
Display Cettina

Dansk
|§| Network Deutsch

Espafiol -
(] Bxensions

La ¢ English (built-in)
Proxy ﬁurtumu?(:: Orade'Corpnr:tinn

o) (o ] [ )

FicurE 2-2. Language Settings

Creating Virtual Machine Images

Procedure

1. Open VirtualBox.



http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
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The VirtualBox Manager window opens.

§% Oracle VM VirtualBox Manager
File Machine Help

(E=1 | HOR Ex3|

@ @
A 4 B4
New Settings Discard Start,

€23 Details

(& Snapshots
* | Welcome to VirtualBox!

‘The left part of this window is a list of all virtual machines on your computer. The list is empty now because you haven't
created any virtual machines yet.

In order to create a new virtual machine, press the New button in the main tool bar
located at the top of the window.

7 ’ -\
b B
You can press the F1 key to get instant help, or vist www.virtualbox.org for the latest
information and news.

_-’_;

m

Ficure 2-3. VirtualBox Manager
2. Click New.
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The Create Virtual Machine window opens.

P

&, Create Virtual Machine

Name and operating system

Please choose a descriptive name for the new virtual machine and select the
type of operating system you intend to install on it. The name you choose will
be used throughout VirtualBox to identify this machine.

Mame: |

Tipe: [Wauwﬁwm v]%ﬁ

Version: | Windows 7 (64-bit)

opmtaie) [ e

Ficure 2-4. Create Virtual Machine

3. On the Name and operating system screen, configure the following:
+  Name: Type a permanent name for the virtual machine.
+  Type: Select Microsoft Windows.

. Vetsion: Select Windows XP, Windows 2003, Windows 7, Windows 8,
Windows 8.1, Windows 2008/2008 R2, Windows 2012/2012 R2 or Windows
10.

4. Click Next.




OVA File Creation Using New Virtual Machine Images

The Memorty size screen appears.

@ Create Virtual Machine

Memory size

Select the amount of memary (RAM) in megabytes to be allocated to the
virtual machine.

The recommended memory size is 512 MB.
() 1024 = MB

4 MB 2048 MB

Net || cancel

FiGuRE 2-5. Memory Size
5. Specify the recommended memory size for your operating system.
+  Windows XP and Windows Server 2003: 512 MB

. Windows 7/8/8.1/10, Windows Server 2008/2008 R2 and Windows Server
2012/2012 R2: 1024 MB

6. Click Next.
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The Hard disk screen appears.

L7 =S
@ Create Virtual Machine

Hard disk

If you wish you can add a virtual hard disk to the new machine. You can either
create a new hard disk file or select one from the list or from another location
using the folder icon.

If you need a more complex: storage set-up you can skip this step and make
the changes to the machine settings once the machine is created.

The recommended size of the hard disk is 25.00 GB.

() Do not add a virtual hard disk
@ Create a virtual hard disk now
(71 Use an existing virtual hard disk file

Empty

| create || cancel

Ficure 2-6. Hard Disk

7.  Select Create a virtual hard disk how and then click Create.
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The Hard disk file type screen appears.

L7 (==
u Create Virtual Hard Disk

Hard disk file type

Please choose the type of file that you would like to use for the new virtual hard disk. If you
do not need to use it with other virtualization software you can leave this setting

unchanged.
() VDI (VirtualBox Disk Image)
@ VMDK (Virtual Machine Disk)
() VHD (Virtual Hard Disk)
) HDD (Parallels Hard Disk)
) QED(QEMU enhanced disk)
) QCOW (QEMU Copy-Dn-Write)

Exp:rtMud=][ MNext ][ Cancel

Ficure 2-7. Hard Disk File Type

8.  Select VDI (VirtualBox Disk Image) or VMDK (Virtual Machine Disk) and then
click Next.
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The Storage on physical hard disk screen appears.

@ Create Virtual Hard Disk

Storage on physical hard disk

Please choose whether the new virtual hard disk file should grow as it is used (dynamically
allocated) or if it should be created at its maximum size (fixed size).

A dynamically allocated hard disk file will only use space on your physical hard disk as it
fills up (up to a maximum fixed size), although it will not shrink again automatically when
space on it is freed.

A fixed size hard disk file may take longer to create on some systems but is often faster to
use.

You can also choose to split the hard disk file into several files of up to two gigabytes each.
This is mainly useful if you wish to store the virtual machine on removable USB devices or old
systems, some of which cannot handle very large files.

@ Dynamically allocated
" Fixed size
[7] splt inte files of less than 2GB

Mext ][ Cancel

Ficure 2-8. Storage on Physical Hard Disk

9.  Seclect Dynamically allocated and then click Next.

O Important
L *

Do not select Fixed size or Split into files of less than 2GB.
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The File location and size screen appears.

@ Create Virtual Hard Disk

File location and size

Please type the name of the new virtual hard disk file into the box below or click on the
folder icon to select a different folder to create the file in.

En_win7splen_offices_noabl [E

Select the size of the virtual hard disk in megabytes. This size is the limit on the amount of
file data that a virtual machine will be able to store on the hard disk.

lj 25.00 GB

4.00 MB 2.00TH

Create | | Cancel

Ficure 2-9. File Location and Size
10. (Optional) Click the folder icon to change the path of the virtual disk file.
11.  Specify the recommended virtual disk size for your operating system.

+  Windows XP and Windows Server 2003: 15 GB

. Windows 7/8/8.1/10, Windows Server 2008/2008 R2 and Windows Server
2012/2012 R2: 25 GB

12. Click Create.
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VirtualBox creates the virtual machine. The new virtual machine appears in the left
pane of the VirtualBox Manager screen.

¥# Oracle VM VirtualBox Manager (=1 EeE (|
File Machine Help

@@ .

New Settings Discard Start

5? = General
Name: En_win7splen_offices_noab

Operating System:  Windows 7 (32-bit)

[# system (v
Base Memory: 1024 MB En_win7splen_offices_noab)
Boot Order:  Floppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-, Nested Paging, Hyper-V
Paravirtualization
Display
Video Memory: 18MB L
Remote Desktop Server: Disabled 3
Video Capture: Disabled
Storage
Controller: SATA

SATAPort0:  En_win7splen_offices_noab.vmdk (Normal, 25.00 GB)
SATAPort1:  [Optical Drive] Empty

{5 Audio

Host Driver:  Windows DirectSound
Controller:  Intel HD Audio

& Network

Adapter 1: Intel PRO/1000 MT Desktop (NAT) L4

& uss

USB Controller:  OHCT
Device Fiters: 0 (0 active)

1 Charad fnldare

Ficure 2-10. Newly-created Virtual Machine

13. Click Settings.
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The Settings window opens.

{23 En_win7splen_offices_noab - Settings [ ==
[ General General

[ system Basic | Advanced | Description | Encryption |

Display Name: En_win7splen_offices_noab

Storage Type: | Microsoft -) ri "_'
Pa Audo Version: | Windows 7 (32-b) -
BY Network

¢ Serial Ports

(P usB

L] Shared Folders

[Tl user Interface

Invalid settings detected [ ok |[ cancel |[ Hep |

Ficure 2-11. VirtualBox Settings

14. In the left pane, click System.
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The System screen appears.

{3 En_win7splen_offices_noab - Settings (7 |[=ss)

@ General System
System Motherboard | Processor | Acceleration |
Display Base Memory: ) 1024 MB =
Storage 4 MB 2048 MB

Boot Order: Floppy
b= Audio @ Optical

Hard Disk
BY Network [ &P Network
¢S Serial Ports Chipset:
& ws Fog Dves
Extended Features: [V| Enable I/0 APIC
E Shared Folders [ Enable EFI (special OSes only)
[FT] user Interface [7] Hardware Clock in UTC Time
Invalid settings detected [ ok |[ cancel |[ Hep |

FiGuRE 2-12. System Screen

15.  On the Motherboatd tab, configure the following:

. Chipset: Select ICH9

. Pointing Device: Select USB Tablet

. Extended Features: Sclect Enable 1I/O APIC

16. Go to the Processor tab and then select Enable PAE/NX.

17. Go to the Acceleration tab and then select Enable VT-x/AMD-V and Enable

Nested Paging.

ﬁ Note

The Acceleration tab is only available if the processor of the host system supports
virtualization technology and the virtualization setting is enabled in the BIOS of the

host system.
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18. In the left pane, click Storage.

The Storage screen appears.

{23 En_win7splen_offices_noab - Settings ==
[ General Storage
@ System Storage Tree Attributes
Display 4 Controller: SATA @B Name: SATA
; En_win7splen_offices_noab.v... Type: [AHC[ -
& storage @) Empty Port Count: 2 =
{pi Audio [ Use Host 1/0 Cache
BY Network
¢ Serial Ports
&P uss
L] Shared Folders
[FT] user Interface
BE&
Invalid settings detected [ ok ][ cancel |[ Heb |

Ficure 2-13. Storage Screen

19. (Optional) If Controller: SATA appears under Storage Tree, remove the SATA
controller and then add the virtual hard drive to the IDE controller.

a.  Click Controller: SATA and then click € to remove the default controller.

b.  Click Controller: IDE and then click [gh.
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The following message appears:

' (33 VirtualBox - Question 7 e |

% ‘You are about to add a virtual hard disk to
! controller IDE.

Would you like to create a new, empty file to
hold the disk contents or select an existing one?

Create new disk| |Choose existing disk| |  Cancel

Ficure 2-14. Choose Existing Disk

c.  Click Choose existing disk and then select the virtual hard disk file that you
previously created.

d.  Under Attributes, retain all default settings.

e.  Under Storage Ttree, click Controller: IDE and then click the empty optical
drive icon.

f.  Under Attributes, verify that CD/DVD Drive is IDE Secondary Master.
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3 En_win7splen_offices_noab - Settings (2=
.@: General Storage
@ System Storage Tree Attributes
| [ oo )
— En_win7splen_offices_ncab.v... [7] Live cO/oVD
() storage @ ety Information
b Audio LI =
Size: -
@ Network Location: -
Attached to: —
73 serial Ports
&7 usB
[l Shared Folders
=] user interface
BE&
Invalid settings detected [ ok | cancel |[ Hep |

Ficure 2-15. IDE Secondary Master
20. Under Attributes, click

, and then select Choose a virtual CD/DVD disk file....

21. Select the ISO file containing the operating system installer.

The ISO file is available as a device.

22. (Optional) In the left pane, click Audio and then deselect Enable Audio.
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€3 En_win7splen_offices_noab - Settings .
[H] General Audio

& system [7] Enable Audio

Display Host Audio Drver: [Windows DirectSound .
Storage Audio Controllr: [Intel HD Audio =
o Audio

B Network

£ serial Ports

(5 usB

] Shared Folders

E] User Interface

e — o) (ot ) [

Ficure 2-16. Audio Options Settings
23. In the left pane, click USB and then select Enable USB Controller.

7\ Important

" Verify that USB 1.1 (OHCI) Controller s sclected.
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{23 En_win7splen_offices_noab - Settings (7 ==
[ General use
System Enable USB Controller
Display @ USB 1.1 (OHCT) Controller
— (7) USB 2.0 (EHCI) Controller
Storage () USB 3.0 (xHCI) Controller
i;g Audio USB Device Filters
BY Network ﬁ
¢ Serial Ports pe:]
(5 uss -
L] Shared Folders e
[FT] user Interface

Invalid settings detected [ ok |[ cancel |[ Hep |

Ficure 2-17. Enable USB Controller

24. In the left pane, click Shared Folders and then verify that no folders are shared.
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{23 En_win7splen_offices_noab - Settings (7 ==
[ General Shared Folders

System Folders List

Display Name Path Auto-mount  Access | i3
soroge Machine Folders :
o Audio

BY Network

¢ Serial Ports

(> uss

L] Shared Folders

[FT] user Interface

Invalid settings detected [ ok |[ cancel |[ Heb |

Ficure 2-18. Shared Folders Settings
25, Click OK.

The Settings window closes.

26. On the VirtualBox Manager screen, click ;ﬁ to power on the image.
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§# Oracle VM VirtualBox Manager (=3 |E=E[E=]
File  Machine Help

@ @ ol@.

New Settings Discard | Start

% =l General = preview i
Name: En_win7splen_offices_noab

Operating System:  Windows 7 (32-bit)

(@l Snapshots

[ system @

Base Memory: 1024 MB En_win7splen_offices_noab|
BootOrder:  Floppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-Y, Nested Paging, PAE/NX

Display

Video Memory: 27M8

Remote Desktop Server:  Disabled =
Video Capture: Disabled

Storage

Controller: IDE
IDE Primary Master:  -isk1.vmdk (Normal, 25.00 GB)
IDE Secondary Master: ~ [Optical Drive] Empty

{5 Audic

Disabled

& Hetwork

Adapter 1:  Intel PROJ1000 MT Desktop (NAT)

& vse |

Disabled

[ shared folders

Nene

Ficure 2-19. VirtualBox Manager

The installation process starts.

27. Follow the on-screen instructions to install the guest operating system.
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En_win7splen_offices_noab [Running] - Oracle VM VirtualBox ===
File Machine View Input Devices Help

% Install Windows

#‘_
Windows 7

Language to : [English
ROGEEL LR BB LR £ rglish (United States)

Keyboard or input method: [T

Enter your language and other preferences and click “I

03 Micrasoft Corporation. All rights reserved.

B ® e &= @@ @ & richtcrl

Ficure 2-20. Operating System Installation Process

28. Install Microsoft Office and other software to achieve satisfactory detection results.

Modifying the Virtual Machine Environment

Modify the virtual machine environment to run Virtual Analyzer Sensors, a collection of
utilities that execute and detect malwate, and record all behavior in Virtual Analyzer.

«  Moditying the Virtual Machine Environment (Windows XP and Windows Server
2003) on page 2-25

. Modifying the Virtual Machine Environment (Windows 7/8/8.1/10, Windows
Server 2008/2008 R2 and Windows Server 2012/2012 R2) on page 2-27
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Modifying the Virtual Machine Environment (Windows XP
and Windows Server 2003)

Procedure

1. Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2. Perform the following tasks:

Task STEPS

Set the "Administrator” Type net user "Administrator" 1111.
logon password to "1111".

Configure automatic logon | a. Type the following commands:
from the “Administrator”

account. . REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£

The logon prompt is
bypassed and the
“Administrator”

REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t

account is REG SZ /d 1111 /f

automatically used -

to log on to the + REG ADD "HKEY LOCAL MACHINE\SOFTWARE
system every time \Microsoft\Windows NT\CurrentVersion
the virtual machine \Winlogon" /v AutoAdminLogon /t
starts. REG_SZ /d 1 /f

b. Restart the image.




Virtual Analyzer Image Preparation Tool Users Guide

Task STEPS

ﬁ Note

No logon prompt is displayed and the
“Administrator” account is automatically used to
log on.

j’ Administrator

8 Internet _-_\) My Documents
Inkernet Explarer
= ] 5 My Recent Documents
j} My Pictures
- -
MSM _-_/ My Music
" My Computer
e Windows Media Player 5!
& Contral Panel
,,3 Windows Messenger

E-mail
Microsoft Office Outlook,

@, Set Program Access and
Defaults

Microsoft OFfice Excel 2003 .
. |- Printers and Faxes
'@ Tour Windows P @) Help and Support
b | Files and Settings Transfer I') Search
Wizard
=) Run...

All Programs D

ﬁ| Log OFF @D | Turn OFf Computer

74 start

Ficure 2-21. Windows XP Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.
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Task STEPS

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.

all installed network . . .
The configuration of all installed network adapters

adapters . - .
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network Type netsh interface ip set address

adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall. | Type netsh firewall set opmode mode=DISABLE.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

3.  Restart the virtual machine.

Modifying the Virtual Machine Environment (Windows
7/8/8.1/10, Windows Server 2008/2008 R2 and Windows
Server 2012/2012 R2)

Procedure

1. Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2. Perform the following tasks:
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Task STEPS

Enable the “Administrator” | Type net user “Administrator” /active:yes.
account.

Set the logon password Type net user "Administrator" 1111.
for the “Administrator”
account to “1111”.

Configure automatic logon | a. Type the following commands:

from the administrator
account + REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£

Each time the
image starts, the
logon prompt is
bypassed and the
“Administrator”

N REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG_Sz /d 1111 /f

account is - REG ADD "HKEY_LOCAL MACHINE\SOFTWARE
automatically used \Microsoft\Windows NT\CurrentVersion
to log on to the \Winlogon" /v AutoAdminLogon /t

system. REG SZ /d 1 /£
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Task STEPS

ﬁ Note

In Windows Server 2008/2008 R2 and
Windows Server 2012/2012 R2, launch
the Local Security Policy snap-in
(secpol.msc) to disable the Password
must meet complexity requirements
Local Security Setting.

#: Local Security Settings EHE E\

File Action View Help
e 2

P secuny Setings

& Policy Security Setting
=8 Account Policies [&8|Enforce password history 12 passwords reme..
Ziiiﬁ:l?ff!lfﬁ - [B¥]tasinum password age 42 days
|88 e HMninum pessverd age 0days
R Ptk Key Peces @]rinimum password length 8 characters
5-{E0 Software Resirition Pock @]Password must meet complexity requirements Ervai\‘ez
Disable

FiGure 2-22. Disable Password must
meet complexity requirements

. Restart the image.
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Task STEPS

No logon prompt is displayed and the
“Administrator” account is automatically used
to log on.

i 2
—
]I Getting Started »

u Connect to a Projector
%) Remote Desktop Connection

Sticky Notes

6& Snipping Tool

Calculatar

.‘;[ Paint

il XPSViewer

& Windows Faxand Scan
"‘"5’1 RS Default Programs

@ Micrasoft Office Word 2003 Help and Support

¥ All Programs

el
e - ©

FicurE 2-23. Windows 7 Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.
all installed network
adapters
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3.

Task

STEPS

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network
adapter to use DHCP

Type netsh interface ip set address
name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Configure AutoPlay

a. Go to Control Panel > AutoPlay.

)v‘w » Control Panel » All Control Panel ltems » AutoPlay
L s = o o o e

Choose what happens when you insert each type of media or device
Use AutoPlay for all media and devices

Media

&9 Audio CD [ choose a defautt -
9 Enhanced audio CD [ choose a defautt -
& DVD movie [ choose a defautt -
& Enhanced DVD movie [ choose a defautt -
{il Software and games [E2 stal o run program from your media -]

FiGure 2-24. AutoPlay

b. For Software and games, select Install or run
program from your media.

c. Click Save.

Disable Windows Firewall.

Type netsh advfirewall set allprofiles state
off.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

Restart the virtual machine.
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Reducing the Size of VirtualBox Disk Images

Procedute

1.
2.

Uninstall unnecessary applications and optional Windows components.
Run Disk Cleanup to free up space on the hard disk.

The utility searches for files and data that you can safely delete, including:
+  Temporary Windows and Internet files

. ActiveX controls, Java applets, and other downloaded program files

+  Files in the Recycle Bin

For details, see the Microsoft Help: http://windows.microsoft.com/en-us

windows/delete-files-using-disk-cleanup#delete-files-using-disk-

cleanup=windows-7.

Use Deployment Image Setvicing and Management (DISM) to free up space on
the hard disk.

DISM is a command-line utility that can be used to free up disk space by managing
the Windows Component Store (WinSxS directory).

For details, see the Microsoft Developer resource website: https://
msdn.microsoft.com/en-us/windows/hardware/commercialize /manufacture/

desktop/clean-up-the-winsxs-folder

a.  Open a Command Prompt window.

ﬁ’ Note

Depending on the Windows version, not all of the following commands may be
supported.

b. Typedism /Online /Cleanup-Image /SPSuperseded.

c. Typedism /Online /Cleanup-Image /StartComponentCleanup /
ResetBase.

Download SDelete and then zero out the free space on the hard disk.



http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
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SDelete is a free command-line utility that securely deletes existing files and
permanently erases file data in unallocated clusters of a disk. The utility can also
ensures that even encrypted files cannot be recovered by overwriting all
addressable locations with new and random characters.

a.  Download sdelete.zip from the Windows Sysinternals website: https://
technet.microsoft.com/en-us/sysinternals/sdelete.aspx

b. Extract sdelete.exe.
c.  Open a Command Prompt window.
d.  Go to the folder that contains sdelete.exe.
e. Type sdelete -z [drive letter].
SDelete zeroes the free space on the hard disk.
5. Shut down the virtual machine.
6. Open a Command Prompt window on the host system.

7. Type "C:\Program Files\Oracle\VirtualBox\VBoxManage.exe"
modifyhd [path\[vm name.vdi] --compact.

The virtual hard disk drive size is reduced.

Exporting Virtual Machine Images to OVA Files

A virtual machine image comprises many uncompressed files. The files must be
combined into a single OVA file to avoid issues when importing.



https://technet.microsoft.com/en-us/sysinternals/sdelete.aspx
https://technet.microsoft.com/en-us/sysinternals/sdelete.aspx
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O Important
o

Verify that the size of the created OVA file is supported by your product.
TaBLE 2-2. Maximum OVA File Size

Probuct VERSION Maximum FiLE SizE
Deep Discovery Inspector 3.8 and earlier 10 GB
3.8 Service Pack 1 | 20 GB
and later
Deep Discovery Analyzer 5.1 and earlier 10 GB
5.5 20 GB
Deep Discovery Email Inspector 2.1 and earlier 10 GB
25 20 GB

Trend Micro TippingPoint Advanced 3.8 Service Pack 2 | 20 GB
Threat Protection for Networks

Trend Micro TippingPoint Advanced 2.5 20 GB
Threat Protection for Email

Trend Micro TippingPoint Advanced 5.5 20 GB
Threat Protection Analyzer

Procedure

1. On the VirtualBox Manager screen, power off the virtual machine.

Note

Verify that the CD/DVD drive is empty before poweting off and exporting.

2. Go to File > Export Appliance.
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The Export Virtual Appliance window appears.

U Export Virtual Appliance

Virtual machines to export

Please select the virtual machines that should be added to the appliance. You can select
more than one. Flease note that these machines have to be turned off before they can be
exported,

En_win7splen_offices_noab

ExpertMode] [ Mext ] [ Cancel

Ficure 2-25. Export Virtual Appliance

3. Select the virtual machine image to export and then click Next.
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The Storage settings screen appears.

[T )
@ Export Virtual Appliance

Storage settings

Flease choose a filename to export the OVF/OVA to.

If you use an ova extension, then all the files will be combined into one Open Virtualization
Format Archive.

If you use an ovfextension, several files will be written separately.

Other extensions are not allowed.

File:  C:\Users\Administrator\Documents'\En_win7spien_offices_noab.ova IE

Format: [QVF 1.0 - |

[ wirite Manifest file

Mext ] [ Cancel

FicurE 2-26. Storage Settings

4.  Configure the following:
+  File: Accept the default name and path or click .L'i:?] to select a different file.

. Format: Select OVF 1.0.

“ Important

Format options include OVF 0.9, 1.0 and 2.0. Virtual Analyzer does not
support OVF 2.0.
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Click Next.

The Appliance settings screen appears.

[T Sl
@ Export Virtual Appliance

Appliance settings

This is the descriptive information which will be added to the virtual appliance. You can
change it by double dicking on individual lines.

*

Description Configuration

€8 Name En_win7splen_offices_noab
& Product

& Product-URL

& Vendor

& Vendor-URL

@ Version

@ Description
(%) Lirancao -

m

Restore Defaults][ Export ]’ Cancel

Ficure 2-27. Appliance Settings

Verify that the License field is empty and then click Export.
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VirtualBox creates the OVA file.

N¢ Exporting Appliance ...: Export appliance 'C:\Users\Administrator\Docu... [=5]

Exporting to disk image 'En_win7splen_offices_noab-disk1.vmdk' ... (2/3)

- 7% X

28 minutes remaining

Ficure 2-28. Disk Image Export Progress Bar
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Chapter 3

OVA File Creation Using Converted
Virtual Hard Disk Drives

Learn how to prepare and import an OVA file in the following topics:

Moditying the Virtual Machine Environment on page 3-6
Exporting Virtual Machine Images on page 3-16
Converting VMware ESXi Virtual Hard Disk Drives on page 3-23

Creating Virtual Machine Images Using Converted Virtual Hard Disk Drives on
page 3-30

Conftiguring Virtual Machine Images on page 3-46

Exporting Virtual Machine Images to OVA Files on page 3-51
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Creating OVA Files Using Converted Virtual
Hard Disk Drives

Procedure
1. Prepare Adobe Reader.
For details, see Preparing Adobe Reader on page 3-5
2. Modify the environment of the virtual machine image.
For details, see Moditying the Virtual Machine Environment on page 3-6.
3. Export the virtual machine image.
For details, see Exporting Virtual Machine Images on page 3-10.
4.  Convert the virtual hard disk drive of the exported image to the VirtualBox format.
For details, see Converting VMware ESXi Virtual Hard Disk Drives on page 3-23.
5. Create a new virtual machine image using the converted virtual hard disk drive.

For details, see Creating Virtual Machine Images Using Converted Virtual Hard
Disk Drives on page 3-30.

6. Configure the new virtual machine image.
For details, see Configuring Virtual Machine Images on page 3-40.
7.  Export the virtual machine image to an OVA file.

For details, see Exporting Virtual Machine Images to OVA Files on page 3-51.

Required Software

The following software must be installed on the virtual machine to achieve satisfactory

detection results.
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TaBLE 3-1. Required Applications

SOFTWARE DESscRIPTION
Operating system Virtual Analyzer supports the following operating systems:
Windows XP
Windows 7

Windows 8/8.1

Windows 10
+  Windows Server 2003/2003 R2
+  Windows Server 2008/2008 R2
+  Windows Server 2012/2012 R2

O Important
<«

- Package the installer as an ISO file.

- Verify that Windows is activated with a valid product
key.

«  Use a computer name that reflects your organizations'
naming scheme.

- Disable automatic updates.

+  Trend Micro recommends using the English version of
the listed operating systems.
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SOFTWARE

DESCRIPTION

Microsoft Office

Virtual Analyzer supports the following versions:
+ 2003 (32-bit)
« 2007 (32-bit)

« 2013 (32-bit and 64-bit)
« 2016 (32-bit and 64-bit)

(
(
- 2010 (32-bit and 64-bit)
(
(

S
o

ortant

Do not install Microsoft Office using Office Click-to-
Run, or a disk image obtained from Click-to-Run. Use
a MSI installer to install Microsoft Office. For details,
see What is Click-to-Run.

After installation, open all Microsoft Office applications
and verify that the main editing screen is displayed. If
any confirmation dialog or welcome screen displays,
make any selection to close the screen and display the
main editing screen.

Welcome to Microsoft Office 2010 =

Help Protect and Improve Microsoft Office _J&OfﬁE“e"

Use Recommended Settings

o ®) Tnstal important an Office, W Offerme and
Mierosoft software, check online for salutions to prablems, download fles to heip Microsoft diagnose system prablems, autamatically
update Office content, and help imprave Office

0 Install Updates Only

© Instal important and for Office, Windons and other Microsoft software. Offer me new optional Office and
Microsoft softnare,

o Don't make ch

%) Choosing this option o

Getmore information on how to turn these settings on and off
sent o Microsoft, is not used to denty or contact you.
fead our privacy statement,

Ficure 3-1. Help Protect and Improve Microsoft
Office

Verify that your license allows you to virtualize the
applications. For details, see https://support.office.com.

Disable automatic updates.

Enable macros. For details, see Enable or disable
macros in Office files



https://technet.microsoft.com/en-us/library/jj219427.aspx#WhatIs
https://support.office.com
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
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SOFTWARE DESCRIPTION

Adobe Reader Install the version of Adobe Reader that is most widely used in
your organization. To download the most current version of Adobe
Reader, go to http://www.adobe.com/downloads/.

If you do not install Adobe Reader, Virtual Analyzer:

Installs Adobe Reader 8, 9, and 11 on all Windows XP and
Windows Server 2003/2003 R2 images during importing.

+ Installs Adobe Reader 9, 11, and DC on all Windows 7 and
newer images during import.

Uses all versions during analysis.

WARNING!

This consumes additional computing resources.

+ Installs .NET Framework 3.5 or later if the operating system
is Windows XP or Windows Server 2003.

Configure Adobe Reader to manually check for and install
updates. For details, see https://helpx.adobe.com/acrobat/kb/
reader-acrobat-updater-settings.html.

O Impottant
. ®

Do not install VMware tools to avoid triggering the anti-virtual machine functions of some
malware.

Preparing Adobe Reader

Perform the following steps if Adobe Reader is installed on the virtual machine.

Procedure
1. Disable automatic updates.

For details, see http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-

acrobat-reader.html.



http://www.adobe.com/downloads/
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-acrobat-reader.html
http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-acrobat-reader.html
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2. Install the necessary Adobe Reader language packs so that Virtual Analyzer can
process files authored in languages other than those supported in your native
Adobe Reader.

For example, if you use the English version of Adobe Reader and you expect to
analyze files authored in East Asian languages, install the Asian and Extended
Language Pack.

3.  Start Adobe Reader.

“ Important

Perform this step before exporting the virtual machine.

Modifying the Virtual Machine Environment

Modify the virtual machine environment to run Virtual Analyzer Sensors, a collection of
utilities that execute and detect malware, and record all behavior in Virtual Analyzer.

«  Moditying the Virtual Machine Environment (Windows XP and Windows Server
2003) on page 3-6

. Modifying the Virtual Machine Environment (Windows 7/8/8.1/10, Windows
Server 2008/2008 R2 and Windows Server 2012/2012 R2) on page 3-9

. Uninstalling VMware Tools on page 3-14

Modifying the Virtual Machine Environment (Windows XP
and Windows Server 2003)

Procedure

1. Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2. Perform the following tasks:
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Task STEPS

Set the "Administrator” Type net user "Administrator" 1111.
logon password to "1111".

Configure automatic logon | a. Type the following commands:
from the “Administrator”

account. . REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£
The logon prompt is
bypassed and the
“Administrator”

o REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t

account is REG Sz /d 1111 /f

automatically used -

to log on to the + REG ADD "HKEY LOCAL MACHINE\SOFTWARE
system every time \Microsoft\Windows NT\CurrentVersion
the virtual machine \Winlogon" /v AutoAdminLogon /t
starts. REG Sz /d 1 /£

b. Restart the image.
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Task STEPS

ﬁ Note

No logon prompt is displayed and the
“Administrator” account is automatically used to
log on.

j’ Administrator

8 Internet _-_\) My Documents
Inkernet Explarer
= ] 5 My Recent Documents
j} My Pictures
- -
MSM _-_/ My Music
" My Computer
e Windows Media Player 5!
& Contral Panel
,,3 Windows Messenger

E-mail
Microsoft Office Outlook,

@, Set Program Access and
Defaults

Microsoft OFfice Excel 2003 .
. |- Printers and Faxes
'@ Tour Windows P @) Help and Support
b | Files and Settings Transfer I') Search
Wizard
=) Run...

All Programs D

ﬁ| Log OFF @D | Turn OFf Computer

74 start

Ficure 3-2. Windows XP Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.
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Task STEPS

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.

all installed network . . .
The configuration of all installed network adapters

adapters . - .
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network Type netsh interface ip set address

adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall. | Type netsh firewall set opmode mode=DISABLE.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

Uninstall VMware Tools. For details, see Uninstalling VMware Tools on page
3-14.

3.  Restart the virtual machine.

Modifying the Virtual Machine Environment (Windows
7/8/8.1/10, Windows Server 2008/2008 R2 and Windows
Server 2012/2012 R2)

Procedure

1. Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2. Perform the following tasks:




Virtual Analyzer Image Preparation Tool Users Guide

Task STEPS

Enable the “Administrator” | Type net user “Administrator” /active:yes.
account.

Set the logon password Type net user "Administrator" 1111.
for the “Administrator”
account to “1111”.

Configure automatic logon | a. Type the following commands:

from the administrator
account + REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£

Each time the
image starts, the
logon prompt is
bypassed and the
“Administrator”

N REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG_Sz /d 1111 /f

account is - REG ADD "HKEY_LOCAL MACHINE\SOFTWARE
automatically used \Microsoft\Windows NT\CurrentVersion
to log on to the \Winlogon" /v AutoAdminLogon /t

system. REG SZ /d 1 /£
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Task STEPS

ﬁ Note

In Windows Server 2008/2008 R2 and
Windows Server 2012/2012 R2, launch
the Local Security Policy snap-in
(secpol.msc) to disable the Password
must meet complexity requirements
Local Security Setting.

#: Local Security Settings EHE E\

File Action View Help
e 2

P secuny Setings

& Policy Security Setting
=8 Account Policies [&8|Enforce password history 12 passwords reme..
Ziiiﬁ:l?ff!lfﬁ - [B¥]tasinum password age 42 days
|88 e HMninum pessverd age 0days
R Ptk Key Peces @]rinimum password length 8 characters
5-{E0 Software Resirition Pock @]Password must meet complexity requirements Ervai\‘ez
Disable

Ficure 3-3. Disable Password must
meet complexity requirements

. Restart the image.
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Task STEPS

No logon prompt is displayed and the
“Administrator” account is automatically used
to log on.

i 2
—
]I Getting Started »

u Connect to a Projector
%) Remote Desktop Connection

Sticky Notes

6& Snipping Tool

Calculatar

.‘;[ Paint

il XPSViewer

& Windows Faxand Scan
"‘"5’1 RS Default Programs

@ Micrasoft Office Word 2003 Help and Support

¥ All Programs

el
e - ©

Ficure 3-4. Windows 7 Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.
all installed network
adapters
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3.

Task STEPS

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is

Yes.
Configure a network Type netsh interface ip set address
adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Configure AutoPlay a. Go to Control Panel > AutoPlay.

)v‘-g » Control Panel » All Control Panel ltems » AutoPlay
Yo = = e — _— = —

Choose what happens when you insert each type of media or device
Use AutoPlay for all media and devices

Media

&9 Audio CD [ choose a defautt -

¢4 Enhanced audio CD [ choose a defautt -]

& DVD movie [ choose a defautt -]
& Enhanced DVD movie [ choose a defautt -
| {il Software and games [E2 stal o run program from your media -]

Ficure 3-5. AutoPlay

b. For Software and games, select Install or run
program from your media.

c. Click Save.

Disable Windows Firewall. | Type netsh advfirewall set allprofiles state
off.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

Uninstall VMware Tools. For details, see Uninstalling VMware Tools on page
3-14.

Restart the virtual machine.
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Uninstalling VMware Tools

VMware Tools will attempt to connect to a VMware ESXi host, which might prevent
VirtualBox from importing the virtual machine image.

Procedure
1. Go to Start > Control Panel.

The Control Panel screen appears.
2. Check the list of installed programs.

. Windows XP and Windows Server 2003: Click Add or Remove Programs.

. Windows 7/8/8.1/10, Windows Server 2008/2008 R2 and Windows Server
2012/2012 R2: Click Programs and Features.
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A list of installed programs appears.

® Add or Remove Programs E| @WZ'

—
Eﬁ-_‘f Currently installed programs: O show updakes Sort by: | Mame v
Mﬁ & | 15 Micrascft NET Framewerk 2.0 Service Pack 1 Size  185.00MB
Prografns §5) Microsoft .NET Framework 3.0 Service Pack 1 Size  245.00M8
% §8) Microscit JNET Framework 3.5 Size  Z5.02MB
ndd'uew C13 Microsoft Office Enterprise 2007 Size  BOB.00MB
Programs £13 Microsoft Office Professional Edtion 2003 Size  349.00MB
g §5) Microsoft isual C-4 2008 Redistributable - x86 9.0.30729.4148 Size  10.19M8
m ¥iware Tools
A [Remove
Windows oL
Components
To change this progranm of remoye it from y COMpLULEr, Change or Remove.
@’ 8 Windowes Irernet Explorer 8 Size 4.36MB
Set Program
Access and
Def aults

Ficure 3-6. Add or Remove Programs (Windows XP)
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@uvlr; ¢ Ceontrel Panel » Programs » Programs and Features v | ¥y [ search ograms and Features F=)

Conitrol Panel Home . I
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
% Turn Windows features on or

Gl Organize v Uninstall = > B
Name : Publisher Inztalled On
[077-Zip 4.65 9/16/2014
I Microsoft NET Framework 4 Client Profile Microsoft Corporation 971772014
..j_!-hli‘:n:;oﬁ JNET Framework 4 Extended Micreseft Corporation 0/17/2014
B3 Microsoft Office Enterprise 2007 Microsoft Corporation 8/17/2014
':‘" Microsoft Office Professional Edition 2003 Microsoft Corporation 8/17/2014
7 Micresoft Visual C- + 2008 Redistributable - <86 9.0.3.. Microsoft Corporation
WJMwue Tools Wiware, Inc.

t version: 8.6.5.11214
Help link: hitpy/fwwwy

MWAe.Com

Ficure 3-7. Add or Remove Programs (Windows 7)

3. Select VMwate Tools and then click Remove (Windows XP or Windows Server
2003) ot Uninstall (Windows 7/8/8.1/10, Windows Server 2008/2008 R2 or
Windows Setrver 2012/2012 R2).

4.  Click Yes to uninstall VMwatre Tools.

5.  Click Yes to restart Windows.

VMware Tools is uninstalled.

Exporting Virtual Machine Images

You must verify and modify some settings before exporting a virtual machine image
from VMware ESXi or Workstation.

. Veritying Virtual Machine Settings on VMware Workstation on page 3-17

. Exporting Virtual Machine Images on VMware ESXi on page 3-19
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. Converting VMware ESXi Virtual Hard Disk Drives on page 3-23

Verifying Virtual Machine Settings on VMware Workstation

Procedure
1. Shut down the virtual machine.
2. In the left pane, right-click the virtual machine and then select Settings.

The Virtual Machine Settings scteen appears.

Virtual Machine Setti

Ficure 3-8. Virtual Machine Settings
3. On the Hardware tab, verify the following:
+ CD/DVD (IDE): Connection is Use physical drive.

«  Floppy: Connection is Use physical drive.




Virtual Analyzer Image Preparation Tool Users Guide

Virtual Machine Setti

= Memory 512 MB Connected
[ Processors 1 + | Connect at power on
CiHard Disk (IDE)  15GB
, COYIVD (IDE) Auto detect Connection
ClFopoy  Auodetea | physical arhe:
Fig Metwork Adapter  NAT bl (53
SusBController  Present [ Auto detect -
&)’ Sound Card Auto detect
) Prinker Use floppy image file
& Display Auto detect
Create... Browse...
Read-only

Ficure 3-9. Virtual Machine Settings - Hardware

4. Go to the Options tab and then click General.

5. In the right pane, under Working directory, locate the Virtual Machine Disk
(* . vmdk).
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Limoe

Solaris

VMware ESX

Other
Version:

Working directory

C:\sers\adminstrator\Documents\Virual Mod! [ rowse... |

1/ Suspend and snapshat files will be stored here,

Enhanced virtual keyboard
o

&y The VMware keyboard driver is not installed on the: host.

Ficure 3-10. Working Directory

Exporting Virtual Machine Images on VMware ESXi

Procedure

1. Shut down the virtual machine.

2. In the left pane, right-click the virtual machine and then select Edit Settings.
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(622200 v e . =~

File Edit View Inwventory Administration Plug-ins Help

G & f Home * & Inventory @ Inventory

"l eBEGHRn oD P

B 0 17222130 Bl i : = :

::j ESXI_ win7splen offic noab ESKi xDsn-_‘e.n offices_noab
Power v

Performance

-
Guest il ]
__ Snapshot re computer that, like @ Virtual Machines
@ OpenConsole loperating system and
E Sett fystem installed on a virtual
i Edit ings... perating system
Upgrade Virtual Hardware
— ine 5 an isolated computing -
Add Permission... Ctr+P  hrtual machines as deskiop or =
Report Performance 5 testing environments, or to g
- bns
Rename ts. The same host can run -
Openin New Window... CtrisAlt+N -
Remaove from Inventory kl

Delete from Disk

BATIC TSRS

| Power on the virtual machine

(» Edit virtual machine settings

Tasks root
L J

Ficure 3-11. Edit Settings

The Virtual Machine Properties screen appears.
3. On the Hardware tab, verify the following settings:

. CD/DVD drive 1: Client Device

. Floppy dtive 1: Client Device
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~ - Virtual Machine Properties

Hardware | Ootions | Resources |

[ Show Al Devices ad.. | Remove |
Hardware Summary

o8 Memory 512 MB

@A orus 1

B video card Video card

= VMO device Restricted

= Hard disk 1 Wirtual Disk

5 C0/OVD drive 1 Client Device

B Metwork adapter 1 WM Metwork

& Floppy drive 1 Client Device

Ficure 3-12. Virtual Machine Properties - Hardware

4.  In the left pane, select the virtual machine and then go to File > Export > Export
OVF Template.
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@ 172.22.1.30 - vSphere

File | Edit View Irnventory Administration Plug-ins Help
»
o) v Inventory
Deploy OVF Template...
Export L Export OVF Template...
Report L Export List..
Browse VA Marketplace... Export Maps... roe Allocation | Performance | Events . Console . Permissions
Print Maps : Export System Logs...
N ‘What is a Virtual Machine?
Exit
A virtual machine is a software computer that, lke a Virtssl Machines. -
physical computer, runs an operating system and e 3
applications. An operating system instalied on a virtual s
machine is called a guest operating system X
Because every virtual machine s an isolated computing (
environment, you can use virtual machines as desktop or = s
workstation environments, as 1esting environments, or 1o o=
consolidate server applications
Virtual machines run on hosts. The same host can run
many virtual machines. \|
Basic Tasks
¢ Power on the virtual machine
G Edit virtual machine settings
-
Tasks root
2 4

Ficure 3-13. OVF Template

The Export OVF Ternplate screen appears.
5.  Configure the following settings:

+  Name: Type a name for the virtual machine image.

ﬁ Note

(Optional) Click the folder icon to change the path of the OVF template files.

+  Format: Sclect Folder of files (OVE).

7 Important

Vertify that Include image files attached to floppy and CD/DVD devices in the OVF
package is not selected.

6. Click OK.
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Converting VMware ESXi Virtual Hard Disk Drives

VirtualBox does not support the virtual hard disk drive format (* . vindk) of VMware
ESXi images. Use one of the following tools to convert the disks:

Using VMware vCenter Converter Standalone on page 3-23

. Using QEMU on page 3-29

Using VMware vCenter Converter Standalone

Procedure

1. Download VMware vCenter Converter Standalone from https://

my.vmware.com/web/vmware/info/slug

infrastructure_operations_management/vmware_vcenter_converter standalone/
5_5#product_downloads.

ﬁ Note

VMware vCenter Converter Standalone 5.0 does not support vCenter Server and
ESXi versions later than 5.0. Download and install a version later than 5.0.1.

2. Open VMware vCenter Converter Standalone and then click Convert machine.



https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
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le View Task Administration Help
% Convert machine & Configure machine O

View by: ~ Tasks Show: = Running tasksin ~ Recenttasks
TaskID JobID Source Destination Status Start time End time

Welcome to VMware vCenter Converter Standalone

VMware vCenter Comverter Standalone allows you to take one of a variety of machines and cornvert
it into a new VMware virtual machine. The machines you may corvert include:

Convert . ppysical machines
Maching  _ymware virtual machines (vm)
-VMware Consolidated Backup (.vmx)
- Microsoft VirtualPC's or Virtual Server virtual machines (vmc)
- Symantec LiveState Recovery Image (.sv2i)
- Acronis True Image Backup (.tib)
- StorageCraft ShadowsStor (spf)
- Parallels Virtualization Products (.pvs)
- Hyper¥ virtual machines

Ficure 3-14. VMware vCenter Converter Standalone

The Conversion window opens.

On the Source System screen, configure the following:

a.  Select source type: Select VMware Infrastructure virtual machine.
b.  Setver: Type the ESXi server IP address.

c.  User name, Password: Type the credentials that provide administrator access
to the VMware server.

Click Next.
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The Source Machine screen appears.

Source Machine
Select the virtual machine you want to convert
Source System Source: & 172.22.1.30 Destination: none
Source Machine
Destination System  Inventory for: 172.22.1.30 Search for name with: Clear
Options I =
Summary ‘fM narne_ i Power state
& ESXi_win7splen_offices_noab Powered off
|5 ESXi_xpsp3en_offices_noab | Powered off
Refresh View source details...
‘ 1 13
; Help Export diagnostic logs... IL <Back J' Cancel

Ficure 3-15. Conversion > Source Machine

5. Select the virtual machine that you want to convert and then click Next.
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The Destination System section appears.

Destination System
Select a host for the new virtual machine

Source System Source: @& ESXi_xpsp3en_offices_noab on 172.22.1.30 Destination: none

Source Machine . _
Destination Syste Select destination type: \U'Mware Workstation or other VMware virtual machine x|

Options Creates a new virtual machine for use on YMware Workstation, Viware
Summary Player, VMware Fusion or other VMware product.

Select VMware product: VMware Workstation 6.5 -

Virtual machine details

Name: ESXi_xpsp3en_offices_noab

Select a location for the virtual machine: ) )
¥:\for_USBox3.61\for_virtualbox\ESXi ~ Browse...

‘ 1l [

; Help Export diagnostic logs... | <Back Cancel

Ficure 3-16. Conversion > Destination System
6. Configure the following and then click Next.

a.  Select destination type: Select VMware Workstation or other VMware virtual
machine.

b.  Select VMware product: Select VMware Workstation 6.5.x.

c.  Virtual machine details: Accept the default name and location or click Browse
to select a different file.
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The Options screen appeats.

Options
Set up the parameters for the conversion task

Source: & ESXi_xpsp3en_offic--- Destination: % Y:\for_U---\ESXi (VMware Workstation 6.0.x)
Click on an option below to edit it.

Current settings: ]
Options - Data to copy Edit
Summary Copy type: Disk-based
VirtualDisk1: 15 GB
= Devices Edit

vCPUs: 1 (1 sockets * 1 cores)
Disk controller: Auto select

Memory: 512MB

= Networks Edit
NIC1: Bridged

~ Services Edit
Total: 93 service(s)

- M Advanced options Edit

Install VMware Tools: No
Ay Customize Guest O5: NfA
Remove Restore Checkpoints: Yes
Reconfigure: Yes
=Throttling Edit
CPU: None
Network bandwidth: None

‘ 1l 3

Wl [ Help | Export diagnostic logs... [_<Backjj Next > ] [ Canceld'

Ficure 3-17. Conversion > Options

7. Verify the settings and then click Next.

7 Important

Verify that Install VMware Tools is set to No.

The Summary screen appears.
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Summary
Review the conversion parameters
Source: & ESXi_xpsp3en_offic--- Destination: & Y:\for_U---\ESXi (VMware Workstation 6.0.x)
Destination System Source system information
Options Source type: VMware Infrastructure virtual machine
Summary Source VM: ESXi_»psp3en_offices_noab
Host/'Server: 172.22.1.30
Connected as: root
CPU throttiing: MNone =
Metwork throtting: Mone
Destination system information
Virtual machine name: ESXi_xpspden_offices_noab_convert v
Destination product Wiviware Workstation 6.0.x
Destination directory: Yi\for_USBod.61\or_virtualboX\ESXi
Number of vCPUs: 1 (1 sockets * 1 cores)
Physical memory: s512mB
Network: Preserve NIC count
MNIC1 Connected
Bridged connection
Disk controller type: Auto select i
Storana: . Nigk-hazad clonina
5 = R o« Hi »
Help | Export diagnostic logs... [ < Back | Finish Cancel

Ficure 3-18. Conversion > Summary

8.  Verify the information and then click Finish.
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VMware vCenter Converter Standalone converts the Virtual Machine Disk (* . vindk).

5] vMware vCenter Converter Standalo - "

File View Task Administration Help
% Corvert machine & Configure machine O

Viewby: = Tasks Show: ~ All tasksin ~ Recent tasks

TaskiD  JobID  Source Destination Status Starttime  End time
®3 El 172221 30/E500_xpsp3en_++ \ESXi_xpsp3en offices n- [ ] 2%  2014M12/5+ Estimated time remaining: 1 hours--+

Welcome to VMware vCenter Converter Standalone

WMware vCenter Converter Standalone allows you to take one of a variety of machines and comvert
it into a new VMware virtual machine, The machines you may corvert include:

Corvert . physical machines
Machine  _ynMware virtual machines (vmx)
-VMware Consolidated Backup (vmx)
- Microsoft VirtualPC's or Virtual Server virtual machines (vmc)
- Symantec LiveState Recovery Image (.sv2i)
- Acronis True Image Backup (.tib)
- StorageCraft ShadowStor (spf)
- Parallels Virtualization Products (.pvs)
- Hyper- virtual machines

Ficure 3-19. Image Conversion Progress

Using QEMU

For details on QEMU, see http://wiki.qemu.org/Main_Page.

Procedure

—_

. Download the latest version of QEMU from http://qemu.weilnetz.de/w64/.

2. Install QEMU with the default settings.

3. Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

4.  Convert the Virtual Machine Disk (* . vmdk) by typing the following command:

gemu-img.exe convert [-f fmt] [-O output fmt] filename
output filename.



http://wiki.qemu.org/Main_Page
http://qemu.weilnetz.de/w64/
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For example:

"C:\Program Files\gemu\gemu-img.exe" convert -f vmdk -O vmdk
C:\ESX_xpsp3en_offices noab.vmdk C:\ESX xpsp3en_offices noab_converted.vmdk

The * . vmdk file can be used to create an OVA file using VirtualBox.

Creating Virtual Machine Images Using Converted Virtual
Hard Disk Drives

Use VirtualBox to create a new virtual machine image.
«  Downloading and Installing VirtualBox on page 2-5

. Creating Virtual Machine Images Using VirtualBox on page 3-31

Downloading and Installing VirtualBox

Procedure

1. Download the latest version of VirtualBox from https://www.virtualbox.org,

wiki/Downloads.

ﬁ Note

The VirtualBox Open Source Edition is licensed under the GPL V2. The full text of
the license is available at http://www.gnu.org/licenses/old-licenses/gpl-2.0.html.

2. Configure the language settings using one of the following methods:

+  Install VirtualBox with English as the default language.

«  After installation, go to File > Prefetences > Language and then select
English.



https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
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< VirtualBox - Preferences 7=
= General Language
@ Input Interface Languages
Defauft -
(&) update English (built-in) I
Bahasa Indonesia 1
Lal 4
@ tongweee | |
Display Cettina
Dansk
@ Network Deutsch
Espafiol il
[ Beensions | o0
Language: English (built-in)
Proxy Author(s): Oracle Corporation

o ) [ cma ][ e ]

Ficure 3-20. Language Settings

Creating Virtual Machine Images Using VirtualBox

Procedute

1. Open VirtualBox.
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The VirtualBox Manager window opens.

§% Oracle VM VirtualBox Manager
File Machine Help

ige g
Lare N K4

New Settings Discard Start,

[E=R{HCIE [Ex3)]

(@) Snapshots

Welcome to VirtualBox!

‘The left part of this window is a list of all virtual machines on your computer. The list is empty now because you haven't
created any virtual machines yet.

In order to create a new virtual machine, press the New button in the main tool bar
located at the top of the window.

7 ’ -\
b B
You can press the F1 key to get instant help, or vist www.virtualbox.org for the latest
information and news.

_-’_;

m

Ficure 3-21. VirtualBox Manager
2. Click New.
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The Create Virtual Machine window opens.

P

&, Create Virtual Machine

Name and operating system

Please choose a descriptive name for the new virtual machine and select the
type of operating system you intend to install on it. The name you choose will
be used throughout VirtualBox to identify this machine.

Mame: |

Tipe: [Wauwﬁwm - ] %ﬂ
Version: | Windows 7 (64-bit) -

opmtaie) [ e

Ficure 3-22. Create Virtual Machine

3. On the Name and operating system screen, configure the following:
+  Name: Type a permanent name for the virtual machine.
+  Type: Select Microsoft Windows.

. Vetsion: Select Windows XP, Windows 2003, Windows 7, Windows 8,
Windows 8.1, Windows 2008/2008 R2, Windows 2012/2012 R2 or Windows
10.

4. Click Next.
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The Memorty size screen appears.

@ Create Virtual Machine

Memory size

Select the amount of memary (RAM) in megabytes to be allocated to the
virtual machine.

The recommended memory size is 512 MB.
() 1024 = MB

4 MB 2048 MB

Net || cancel

Ficure 3-23. Memory Size
5. Specify the recommended memory size for your operating system.
+  Windows XP and Windows Server 2003: 512 MB

. Windows 7/8/8.1/10, Windows Server 2008/2008 R2 and Windows Server
2012/2012 R2: 1024 MB

6. Click Next.
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The Hard disk screen appears.

@ Create Virtual Machine

Hard disk

If you wish you can add a virtual hard disk to the new machine. You can either
create a new hard disk file or select one from the list or from another location

using the folder icon,

If you need a more complex storage set-up you can skip this step and make
the changes to the machine settings once the machine is created.

The recommended size of the hard disk is 25.00 GB.

@ Do not add a virtual hard disk
() Create a virtual hard disk now

(71 Use an existing virtual hard disk file

-disk 1.wmdk (Mormal, 25.00 GB)

[ Create ][ Cancel

Ficure 3-24. Hard Disk

7.  Select Do not add a virtual hard disk and then click Create.
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The following message appears:

o

3¢ VirtualBox - Warning [ B[]

You are about to create a new
I 4, virtual machine without a hard disk.

— ‘You wil not be able to install an
operating system on the machine
until you add one. In the mean time
you will only be able to start the
machine using a virtual optical disk
or from the network.

Continue ][ Go Back

Ficure 3-25. Warning

8. Click Continue.
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VirtualBox creates the virtual machine. The new virtual machine appears in the left
pane.

¥# Oracle VM VirtualBox Manager (=1 EeE (|
File Machine Help

@@ .

New Settings Discard Start

5? = General
Name: En_win7splen_offices_noab

Operating System:  Windows 7 (32-bit)
[# system (v

Base Memory: 1024 MB En_win7splen_offices_noab)

Boot Order:  Floppy, Optical, Hard Disk

Acceleration:  VT-x/AMD-, Nested Paging, Hyper-V
Paravirtualization

Display

Video Memory: 18MB
Remote Desktop Server: Disabled
Video Capture: Disabled

Storage

Controller: SATA
SATAPort1:  [Optical Drive] Empty

{3 Audio

Host Driver: Windows DirectSound
Controller:  Intel HD Audio

n

P Network

Adapter 1t Intel PRO/1000 MT Desktop (NAT) L4

& usB

USB Controller: OHCI
Device Fiters: 0 (0 active)

M Chasad faldase

Ficure 3-26. Newly-created Virtual Machine

9.  Click Settings.
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The Settings window opens.
{23 En_win7splen_offices_noab - Settings [ ==
[ General General
[ system Basic | Advanced | Description | Encryption |
Display Name: En_win7splen_offices_noab
Storage Type: | Microsoft -) ri "_'
Pa Audo Version: | Windows 7 (32-b) -
BY Network
¢ Serial Ports
(P usB
L] Shared Folders
[Tl user Interface
Invalid settings detected [ ok |[ cancel |[ Hep |

Ficure 3-27. VirtualBox Settings

10. In the left pane, click System.
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The System screen appears.

{3 En_win7splen_offices_noab - Settings (7 |[=ss)

@ General System
System Motherboard | Processor | Acceleration |
Display Base Memory: ) 1024 MB =
Storage 4 MB 2048 MB

Boot Order: Floppy
b= Audio @ Optical

Hard Disk
BY Network [ &P Network
¢S Serial Ports Chipset:
& ws Fog Dves
Extended Features: [V| Enable I/0 APIC
E Shared Folders [ Enable EFI (special OSes only)
[FT] user Interface [7] Hardware Clock in UTC Time
Invalid settings detected [ ok |[ cancel |[ Hep |

Ficure 3-28. System Screen
11.  On the Motherboatd tab, configure the following:
. Chipset: Select ICH9.
+  Pointing Device: Select USB Tablet.
. Extended Features: Sclect Enable I/O APIC.
12. Go to the Processor tab and then select Enable PAE/NX.

13. Go to the Acceleration tab and then select Enable VT-x/AMD-V and Enable
Nested Paging.

ﬁ Note

The Acceleration tab is only available if the processor of the host system supports
virtualization technology and the virtualization setting is enabled in the BIOS of the

host system.
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14. In the left pane, click Storage.

The Storage screen appears.

{23 En_win7splen_offices_noab - Settings (7 ==
[ General Storage
@ System Storage Tree Attributes
Display & Controller: SATA @@ Name:  SATA
; @ Empty Type: [AHCI -
[:‘1 ate Port Count: 2 =
i}‘ Audio [] Use Host I/O Cache
BY Network
¢ Serial Ports
(P usB
L] Shared Folders
[FT] user Interface
BE&
Invalid settings detected [ ok ][ cancel |[ Heb |

Ficure 3-29. Storage Screen

15. (Optional) If Controller: SATA appears under Storage Tree, remove the SATA
controller and then add the virtual hard drive to the IDE controller.

a.  Click Controller: SATA and then click € to remove the default controller.

b.  Click Controller: IDE and then click [gh.




OVA File Creation Using Converted Virtual Hard Disk Drives

The following message appears:

' (33 VirtualBox - Question 7 e |

% ‘You are about to add a virtual hard disk to
! controller IDE.

Would you like to create a new, empty file to
hold the disk contents or select an existing one?

Create new disk| |Choose existing disk| |  Cancel

Ficure 3-30. Choose Existing Disk
c.  Click Choose existing disk and then select the converted * . vmdk file.
d.  Under Attributes, retain all default settings.

e.  Under Storage Ttree, click Controller: IDE and then click the empty optical
drive icon.

f.  Under Attributes, verify that CD/DVD Drive is IDE Secondary Master.
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@: General

B system
Display

@ Storage

b Audio

EP Network

73 serial Ports
&7 usB

[l Shared Folders

=] user interface

3 En_win7splen_offices_noab - Settings (2=
Storage
Storage Tree Attributes
@ Controler: I0E [ optcal orve: @
En_win7splen_offices_ncab.v... [7] Live cO/oVD
@ Empty Information
Type: -
Size: -
Location: -
Attachedtor —
BE&>
Invalid settings detected [ ok | cancel |[ Hep |

Ficure 3-31. IDE Secondary Master

16. (Optional) In the left pane, click Audio and then deselect Enable Audio.
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€3 En_win7splen_offices_noab - Settings .
[ General Audio

& system [7] Enable Audio

Display Host Audio Driver: [Windows DirectSound .
Storage Audio Controller: [ Intel HD Audio 5
o Audio

B Network

£ serial Ports

(5 usB

] Shared Folders

E] User Interface

e — o) (ot ) [

Ficure 3-32. Audio Options Settings
17. In the left pane, click USB and then select Enable USB Controller.

7\ Important

" Verify that USB 1.1 (OHCI) Controller s sclected.
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{23 En_win7splen_offices_noab - Settings (7 ==
[ General use
System Enable USB Controller
Display @ USB 1.1 (OHCT) Controller
— (7) USB 2.0 (EHCI) Controller
Storage () USB 3.0 (xHCI) Controller
i;g Audio USB Device Filters
BY Network ﬁ
¢ Serial Ports pe:]
(5 uss -
L] Shared Folders e
[FT] user Interface

Invalid settings detected [ ok |[ cancel |[ Hep |

Ficure 3-33. Enable USB Controller

18. In the left pane, click Shared Folders and then verify that no folders are shared.
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{23 En_win7splen_offices_noab - Settings (7 ==
[ General Shared Folders

System Folders List

Display Name Path Auto-mount  Access | i3
soroge Machine Folders :
o Audio

BY Network

¢ Serial Ports

(> uss

L] Shared Folders

[FT] user Interface

Invalid settings detected [ ok |[ cancel |[ Heb |

Ficure 3-34. Shared Folders Settings
19. Click OK.

The Settings window closes.

20. On the VirtualBox Manager screen, click ;ﬁ to power on the image.
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§# Oracle VM VirtualBox Manager (=3 |E=E[E=]
File  Machine Help
%

o= - @ s
New Settings Discard | Start

=l General = preview Jie
%ﬁi o T
Name: En_win7splen_offices_noab

Operating System:  Windows 7 (32-bit)
[ system @
Base Memory: 1024 MB En_win7splen_offices_noab|

Boot Order:  Floppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-Y, Nested Paging, PAE/NX

Display

Video Memory: 27M8

Remote Desktop Server:  Disabled =

Video Capture: Disabled

Storage

Controller: IDE
IDE Primary Master:  -disk Lumdk (Normal, 25.00 GB)
IDE Secondary Master:  [Optical Drive] Empty

{5 Audic

Disabled

& Hetwork

Adapter 1:  Intel PRO/1000 MT Desktop (NAT)

& vse A

Disabled

[ shared folders

Nene

Ficure 3-35. VirtualBox Manager

21. Install Microsoft Office and other software to achieve satisfactory detection results.

Configuring Virtual Machine Images

Configure virtual machine images that were created using converted virtual hard disk
drives to avoid importing issues.

. Configuring Virtual Machine Images (Windows XP and Windows Server 2003) on
page 3-47

. Configuring Virtual Machine Images (Windows 7/8/8.1/10, Windows Server
2008/2008 R2 and Windows Server 2012/2012 R2) on page 3-50
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Configuring Virtual Machine Images (Windows XP and
Windows Server 2003)

Procedure

1.

2.

On the guest operating system, click Start, right-click My Computer, and then click
Manage.

The Computer Management screen appears.

=] Computer Management E‘ @wg

=) Fie  Action  View ‘Window Help NETET
m R R

L} Computer Management (Local) Hame
= iy System Tools ESy‘ﬂm Tools
& | L] Event Viewer S storage

] Shared Folders i
Ser and Applications

+ Local Lisers and Groups & s

F

Performance Logs and Alert:
B Device Manager

# i Removable Storage
Dk, Defragmenter
Dk Management
# (1 Services and Applcations

Ficure 3-36. Computer Management

In the left pane, click Device Managet.
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A list of devices appeats.

= Computer Management

=) Fle Action View Window Help
« = W& Pm A
= Compuker Management (Local) -
= s System Tooks

# | L] Event Viewer
# ) Shared Folders
xﬁwduwsw&m

Performance Logs and Alert:

Digk Management
# [l Services and Applcations

o]

+ Batberias
+ i Computer
) e Dih drives

@ Display adapters
4 JZh DVD/CD-ROM drives
+ g Human Inkerface Devices
+ (=) IDE ATAJATAPT contrabers
#
#1-T7) Mice and cther pointing devices
= HE Metwork adapbers
BB AMD PCNET Famiy PCI Ethernet Adapher #2
= G Other devices
3 Base System Device
¥ Video Controller (VGA Compatible)
4 Ports (COM & LPT)
4 @ Processors
+ @, Sound, video and game controllers
+ &g Sysbem devices
¥ Universal Serial Bus controllers

Ficure 3-37. Device Management - Network Adapter Window

In the right pane, click Network adapters and then verify that the network adapter

driver is ready.

Open a Command Prompt window (cmd . exe) using an account with

administrator privileges.

Disable the Found New Hardware Wizard by typing the following commands:

. Windows XP 32-bit:

reg add "HKEY LOCAL MACHINE\Software\Policies\Microsoft
\Windows\DeviceInstall\Settings" /v SuppressNewHWUI /t
REG DWORD /d 1 /f

Windows XP 64-bit or Windows Server 2003:




OVA File Creation Using Converted Virtual Hard Disk Drives

reg add "HKEYiLOCALiMACHINE\SYSTEM\CurrentCOntrolSet
\Services\PlugPlay\Parameters" /v SuppressUI /t
REG_DWORD /d 1 /f

Found Hew Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windowrs vwill seanch for curent and updated softveaes by

Icoking on your computed, on the hasdeare instalation CD., o on
the Windows Update Wb site [with powr permission]

Fead ow pevacy pobcy

Can \Windows connect 1o Windows Updabe to search fior
sofbsare?

() ¥es. this time only
() ez, now and gveny time | cornect a device
(2 Mo not thes bme

Chek Nesd ba conlinue.

Ficure 3-38. Found New Hardware Wizard

6. Restart the image and then verify that the Found New Hatdware Wizard does not
appeat.

7.  Power off the image.
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Configuring Virtual Machine Images (Windows 7/8/8.1/10,
Windows Server 2008/2008 R2 and Windows Server
2012/2012 R2)

Procedure

1. On the guest operating system, click Start, right-click Computer, and then click
Manage.

The Computer Management screen appears.

A Computer Management E' @[]
File Action View Help

= |0 = HE

ilﬁf Cemputer Management (Local | pame Actions
| a [} System Teels
(®) Task Scheduler
8] Event Viewer
il Shared Folders
:b_' Lecal Users and Groups
(S Perfermance

I} System Tools Computer Management (L., =
“_: Storage Mare Actions
Do Services and Applications

= Device Manager
4 2 Storage
= Digk Management
:_', Services and Applications

Ficure 3-39. Computer Management

2. In the left pane, click Device Managet.




OVA File Creation Using Converted Virtual Hard Disk Drives

A list of devices appeats.

A Computer Management

File Action View Help

e 2@ EE &
_'&- Cemputer Management (Local
a ff} System Tocls
(D) Tesk Scheduler
[ Event Viewer
] Shared Folders
& Local Users and Groups
() Performance
= Device Menager
4 B3 Storage
= Disk Management
> _'=g Services and Applications

o lE-|wE]
# = tmuskx-PC Actions
&
]é_ Batteries Device Manager s
{E Computer
Mere Actions b

Ca Disk drives
B Display adapters
oy DVD/CD-ROM drives
3‘_;] Human Interface Devices
g IDE ATA/ATAR controllers
= Keyboards
,ij Mice and other pointing devices
I Menitors
4 ¥ Metwork sdapters
&¥ Intel(R) PRO/1000 MT Desktop Adapter
4 -5 Other devices
U5 Base System Device
Y¥ Ports (COM & LPT)
n Processors
(E System devices
W Universal Sermal Bus controllers

Ficure 3-40. Device Management - Network Adapter

3. In the right pane, click Network adapters and then verify that the network adapter

driver is ready.

4.  Power off the image.

Exporting Virtual Machine Images to OVA Files

A virtual machine image comprises many uncompressed files. The files must be
combined into a single OVA file to avoid issues when importing.
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O Important
o

Verify that the size of the created OVA file is supported by your product.
TaBLE 3-2. Maximum OVA File Size

Probuct VERSION Maximum FiLE SizE
Deep Discovery Inspector 3.8 and earlier 10 GB
3.8 Service Pack 1 | 20 GB
and later
Deep Discovery Analyzer 5.1 and earlier 10 GB
5.5 20 GB
Deep Discovery Email Inspector 2.1 and earlier 10 GB
25 20 GB

Trend Micro TippingPoint Advanced 3.8 Service Pack 2 | 20 GB
Threat Protection for Networks

Trend Micro TippingPoint Advanced 2.5 20 GB
Threat Protection for Email

Trend Micro TippingPoint Advanced 5.5 20 GB
Threat Protection Analyzer

Procedure

1. On the VirtualBox Manager screen, power off the virtual machine.

Note

Verify that the CD/DVD drive is empty before poweting off and exporting.

2. Go to File > Export Appliance.
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The Export Virtual Appliance window appears.

U Export Virtual Appliance

Virtual machines to export

Please select the virtual machines that should be added to the appliance. You can select
more than one. Flease note that these machines have to be turned off before they can be
exported,

En_win7splen_offices_noab

ExpertMode] [ Mext ] [ Cancel

Ficure 3-41. Export Virtual Appliance

3. Select the virtual machine image to export and then click Next.
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The Storage settings screen appears.

[T )
@ Export Virtual Appliance

Storage settings

Flease choose a filename to export the OVF/OVA to.

If you use an ova extension, then all the files will be combined into one Open Virtualization
Format Archive.

If you use an ovfextension, several files will be written separately.

Other extensions are not allowed.

File:  C:\Users\Administrator\Documents'\En_win7spien_offices_noab.ova IE

Format: [QVF 1.0 - |

[ wirite Manifest file

Mext ] [ Cancel

Ficure 3-42. Storage Settings

4.  Configure the following:
+  File: Accept the default name and path or click .L'i:?] to select a different file.

. Format: Select OVF 1.0.

“ Important

Format options include OVF 0.9, 1.0 and 2.0. Virtual Analyzer does not
support OVF 2.0.
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Click Next.

The Appliance settings screen appears.

[T Sl
@ Export Virtual Appliance

Appliance settings

This is the descriptive information which will be added to the virtual appliance. You can
change it by double dicking on individual lines.

*

Description Configuration

€8 Name En_win7splen_offices_noab
& Product

& Product-URL

& Vendor

& Vendor-URL

@ Version

@ Description
(%) Lirancao -

m

Restore Defaults][ Export ]’ Cancel

Ficure 3-43. Appliance Settings

Verify that the License field is empty and then click Export.
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VirtualBox creates the OVA file.

N¢ Exporting Appliance ...: Export appliance 'C:\Users\Administrator\Docu... [=5]

Exporting to disk image 'En_win7splen_offices_noab-disk1.vmdk' ... (2/3)

- 7% X

28 minutes remaining

Ficure 3-44. Disk Image Export Progress Bar




@y Renn

Chapter 4

Virtual Analyzer Image Preparation
Tool

Learn how to use the Virtual Analyzer Image Preparation Tool in the following topics:

Overview on page 4-2
Image Validation and Configuration on page 4-4
System Requirements on page 4-3

Using the Tool on page 4-5

Troubleshooting Common Issues on page 4-17
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Overview

The Virtual Analyzer Image Preparation Tool facilitates the creation of custom sandbox
images.

TaBLE 4-1. Features

FEATURE DESCRIPTION

Image creation Create custom sandbox images for the following products:

«  Deep Discovery Inspector 3.8, 3.8 Service Pack 1, 3.8
Service Pack 2, 3.8 Service Pack 3, and 3.8 Service Pack 5

Deep Discovery Email Inspector 2.1, 2.5, 2.5 Service Pack 1,
and 2.6

- Deep Discovery Analyzer 5.1, 5.5, 5.5 Service Pack 1, and
5.8

TippingPoint Advanced Threat Protection for Networks 3.8
SP2, and 3.8 Service Pack 3

«  TippingPoint Advanced Threat Protection for Email 2.5, and
2.5 Service Pack 1

TippingPoint Advanced Threat Protection Analyzer 5.5, and
5.5 Service Pack 1

Deep Discovery Director 1.1

Image validation The tool validates and configures OVA files created using
and configuration VirtualBox.
Note

For images created using VMware, see OVA File Creation
Using Converted Virtual Hard Disk Drives on page 3-1.

Enhanced hardware | Enhanced configuration of universally unique identifiers (UUIDs)
identifier eliminates the need to reactivate Microsoft Windows and
configuration Microsoft Office.
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System Requirements

TaBLE 4-2. System requirements

REQUIREMENT

SPECIFICATION

Host operating
system

Build 3.8.1009 and later:
Windows 7 (32-bit and 64-bit)
Windows 8 (32-bit and 64-bit)
Windows 8.1 (32-bit and 64-bit)
Windows 10 (32-bit and 64-bit)
Build 3.8.1240 and later:
+  Windows Server 2003/2003 R2
+  Windows Server 2008/2008 R2

7\ Important

Microsoft .NET Framework 3.5 or later must be installed on
the host operating system.

Virtualization
application

Oracle™ VM VirtualBox 4.3 or later (except 5.0.6)

O Important
Lo

The tool does not support VirtualBox 5.0.6 because a
defect prevents the first serial port from functioning
properly. Trend Micro recommends using VirtualBox 5.0.7
or later.

For virtual machine images created in VMware, see
Creating OVA Files Using Converted Virtual Hard Disk
Drives on page 3-2.
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REQUIREMENT SPECIFICATION
Hardware The hardware virtualization in the motherboard BIOS of the host
virtualization operating system must be enabled to support Windows 8/8.1/10

or any 64-bit guest operating systems.

Note

The tool can detect hardware virtualization only on
Windows 8/8.1/10 hosts.

Image Validation and Configuration

The tool automatically validates and configures the following VirtualBox image settings.

TABLE 4-3. Validating and configuring image settings

SETTING CoRRECT CONFIGURATION
Admin password 1111
Keyboard layout Enhanced keyboard layout: 101
Found New Hardware Disabled
Wizard
Disk defragmentation Disabled
.NET Optimization Disabled
CPU count 1
Memory size +  Windows XP or Windows Server 2003: 512 MB
+  Other operating systems: 1024 MB
PAE/NX Enabled
Hardware virtualization VT-x/AMD-V and nested paging enabled
Audio driver Enabled
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SETTING CoRRECT CONFIGURATION

Windows SMB service Enabled
(TCP port 445)

File and Printer Sharing for | Enabled
Microsoft Networks

AutoPlay Enabled in Windows 7/8/8.1/10
Microsoft Office macros Enabled
Network adapter settings Obtain an IP address automatically

O Important
. *

The tool checks but does not modify the Windows and Office versions. Verify that the
image meets the requirements before running the tool.

Using the Tool

Procedure

1. Obtain a copy of SandboxWizard.zip from your support provider.

2. Extract the package content to a local folder. Go to the folder and then open
SandboxWizard.exe.
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The introduction screen appears.

Virtual Analyzer Image Preparation Tool [E=H E=R <=

Virtual Analyzer Image Preparation Tool

The Virtual Analyzer Image Preparation Tool facilitates the
creation of custom sandbox images.

Important: To use the tool, install VirtualBox 4.3 or later
(except 5.0.6)

View the readme

v5.0.0.1226 (c) 2016 Trend Micro Inc

Next> ||  Exit

FiGure 4-1. Introduction screen

3. Click Next.

The tool checks if the computer meets the system requirements, and then the
System Requirements screen appears.
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Virtual Analyzer Image Preparation Tool Lo S

System Requirements

Unable to confirm whether hardware virtualization is enabled. Check if this option is
enabled in the motherboard BIOS. Otherwise, issues may occur while preparing
images on Windows & and other supported 64-bit operating systems.

Note: The Toal can detect hardware virtualization only on Windows 8 hosts

VirtualBox 4.3 or newer: 438

CPU hardware virtualization: Mot confirmed

<Back | next> || it

FiGuRrE 4-2. System Requirements screen

4. Click Next.
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The Specify Virtual Machine screen appears.

Virtual Analyzer Image Preparation Tool =NEER
Specify Virtual Machine

The tool will check the image for required applications, and then adjust settings if necessary.

@ Use an OVA image (exported from VirtualBox)

) Select a WM on VirtualBox

OWA file: Browse

Note: The tool will impert the selected OVA file into VirtualBox for validation and
preparation. Depending on the size of the OVA file, the resulting VM can consume
several gigabytes of disk space.

<Back Exit

Ficure 4-3. Specify Virtual Machine screen
5. Specify an OVA file or a virtual machine instance running on VirtualBox.

a.  Select one of the following:

+  Use an OVA image (exported from VirtualBox): Select this option if you
converted a VMware image and then packaged it as an OVA file. For
details, see OVA File Creation Using Converted Virtual Hard Disk
Dirives on page 3-1.
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1 Important

Open Virtualization Format (OVF) is a cross-platform standard for
packaging and distributing software to be run in virtual machines. OVF
enables the creation of ready-to-use software packages (operating systems
with applications) that require no configuration or installation.

An OVF package consists of several files that can be packed into a single
archive file with the extension .ova. Virtual Analyzer supports only
image files in the OVA format.

+  VirtualBox VM: Select this option if you want to create an image based
on an existing virtual machine on VirtualBox.

For example:

Virtual Analyzer Image Preparation Tool = e <=
Specify Virtual Machine

The tool will check the image for required applications, and then adjust settings if necessary.

() Use an OVA image (exported from VirtualBox)

lect 3 VM on VirtualBox

VirtualBox WM: | POC_2k3sp2en_offices_noab_x64_1D15 <
POC_win8luen_offices_noab_ID9_1

POC_ID25_winlOen_offices_noab

POC_2k8sp2en_offices_noab_ID17

En_win7splen_offices_noab_x64_TL

En_xpsp3en_offices_noab_x64_TL

En_win7splen_offices_noab v
[ Clone VM before processing

FiGure 4-4. Specify Virtual Machine screen - Select a VM on
VirtualBox
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b.  Sclect Clone VM before processing to create a new copy of the virtual
machine with its own set of individual snapshots. Cloning allows quick
creation of duplicate environments for testing. You can run as many clones as
the memory and processors on the system allow.

6. Click Next.

The Sandbox Preparation screen appeats.

Virtual Analyzer Image Preparation Tool =R E=N

Sandbox Preparation

47% complete..

Checking the virtual machine settings...
Attaching the serial port...

Powering up the virtual machine...
Checking a few Windows settings...

Cancel

Ficure 4-5. Sandbox Preparation screen

The tool modifies incorrectly configured settings. For a list of settings that the tool

validates, see Image Validation and Configuration on page 4-4. For solutions to
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issues that occur during this phase, see Troubleshooting Common Issues on page
4-17.

7.  Perform one of the following actions depending on the screen that appears:

SCREEN User AcTioN

Ready for Export: The Click Export to OVA to generate a custom sandbox
screen appears when all image in OVA format.

settings are validated.
ﬁ Note

SandboxWizard.exe saves logs in the \1og
folder where you run the tool. Logs use the
following naming convention: d:
\SandboxWizard\log\VATool-
yyyymmddhhmmss output.txt

For example: d:\sandboxWizard\log
\VAT001-20160101091011 output.txt

Preparation Click Retry or Exit.
Unsuccessful: The
screen appears when the
tool is unable to fix issues
encountered during
preparation.

Check the logs and perform any recommended actions
before running the tool again.

If no issues arise, the tool:
. Restarts the virtual machine.

+  Performs the necessary system clean-up.

. Exports the OVA file.
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«  Displays the the Sandbox Ready screen.

Virtual Analyzer Image Preparation Tool ==
Sandbox Ready

@ Avalid image has been prepared successfully. Export the image to an OVA file now
or use VirtualBox to export it later.

VM Mame: En_win7splen_offices_noab

WM settings: Done

Internet Explorer:  Internet Explorer 9.0.8112.16421

Microsoft Office:  Office 2003_2007
R

eader 8.9 11 (virtual An

Adobe Reader: Adobe

yzer will install this

application.)
Adobe Flash: ﬁ:.:cbe F ash.

this application.)
NET: NET Framework 4

View detailed log

[ <Back ! Next=

Ficure 4-6. Sandbox Ready screen

If issues arise and are not resolved, see Troubleshooting Common Issues on page
4-17.

8. Click Next.
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9.

The Specify the OVA image path and file name screen appears.

b

Virtual Analyzer Image Preparation Tool

Specify the OVA image path and file name

Specify a path and file name for the new image. By default, the image is saved in the same folder as

the tool.

Path and file name:  D:\Perforce Workspace\austin_kau_ZG_perforce_ workspace\Core\NCSG\D E]

Estimated image size: 8G

Available disk space: 22 GB on disk(C:\)

[C] Remaove the image from VirtualBox after exporting
[C] Compress the image for uploading to Deep Discovery Director

71 GB on disk(D4)

<Back ‘ MNext i

Ficure 4-7. Specify OVA image path and file name screen

Configure the following settings:

Specify the location and file name that the tool uses when saving the OVA

file.

Note

The tool uses the following naming convention when saving an OVA file:
VAT001-20150205035621.0va
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+  Select Remove the image from VirtualBox after exporting.

Deselect this option if you want to keep the image in VirtualBox even after
exporting.

O Important
o

Unused images consume valuable disk space may impact performance.

+  Select Compress the image for uploading to Deep Discovery Director.

O Important
.

Only Virtual Analyzer images compressed in TAR format by the Virtual
Analyzer Image Preparation Tool can be uploaded to and deployed from Deep
Discovery Director.

10. Click Next.
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The Export the image to OVA screen appears and the tool exports the OVA file.

Virtual Analyzer Image Preparation Tool =NEER
Exporting the image to OVA...

5% complete..

Cancel

Ficure 4-8. Export the image to OVA screen
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The OVA Image Ready screen appears when the export process completes.

Virtual Analyzer Image Preparation Tool [E=H E=R <=
OVA Image Ready

The OWA image file has been created successfully. The image is ready for use in
Virtual Analyzer.

VM Mame: En_win7splen_offices_noab |

Image file: C:\Use_*rs\.ﬂ.dministr_aior\Desktop\Sandboxwizard-lﬂﬁ-
\En_win7splen_offices_noab.ova

Windows: Microsoft Windows 7 Professional SP1 Build 7601 32bit

VM settings: Done [

Internet Explorer:  Internet Explorer 9.0.8112.16421

Microsoft Office:  Office 2003_2007

Adobe Reader: Adobe Reader 8 9 11 (Virtual Analyzer will install this
application.)
AAdnhn Clach: Adobe Flash Plaver Active X 9.0 (Virtual Analvzer will install N

Back to Home Exit

Ficure 4-9. OVA Image Ready screen

11. Click Exit to close the window or click Back to Home to create another image.
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Troubleshooting Common Issues

TaBLE 4-4. Common Issues When Using the Tool

Issue

CAuse

RECOMMENDED ACTION

Unable to upload an
OVA file.

The image does not
meet the minimum
or maximum size
requirements.

Verify that the OVA image is between 1 GB
and 20 GB in size.

Unable to prepare a
virtual machine
image.

The image was not
created using
VirtualBox.

VirtualBox is not
installed on the
computer.

Install a supported VirtualBox version. For
details, see System Requirements on page
4-3.

For virtual machine images created in
VMware, see Creating OVA Files Using
Converted Virtual Hard Disk Drives on
page 3-2.

The image uses an
unsupported
operating system.

Use a supported operating system. For
details, see System Requirements on page
4-3.

VirtualBox is
unresponsive.

Refer to the VirtualBox documentation.

https://www.virtualbox.org/manual/
ch12.html#idp54271008
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Issue CAuse RECOMMENDED ACTION
Unable to start the Settings are Open the imported image using VirtualBox
VirtualBox incorrectly and verify the following Storage settings.
installation CD/ configured. .
DVD. Select Controller: IDE and verify that
the specified type is PlIX4.
oes
i
1] Use Host 1/0 Cache

Ficure 4-10. Controller: IDE must be
set to PlIX4

+  Select the optical disc icon and verify
that the specified CD/DVD drive is
IDE Secondary Master.

@ test - etings )=

Atvibutes
CD/DVD ive: [IDE Secondary Master v | ()

[F] ve copvD.

& Serial Ports sz
5 us Locaton:

S Shared Folders

BEBee

Coma )

Ficure 4-11. CD/DVD drive is set to
IDE Secondary Master
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Issue CAuse REcOMMENDED ACTION
Unable to enter the | Group policy Click OK on the Virtual Analyzer Image
desktop of the guest | settings are Preparation Tool Test screen to enter the
operating system. incorrectly desktop of the guest operating system.
configured.

. Windows 7 Professional
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Issue CAuse RECOMMENDED ACTION

Unable to start AutoPlay settings 1. Open VirtualBox.
SandboxWizard.exe | are incorrectly

in the guest image. | configured. 2. On the VirtualBox Manager screen,

click ;ﬁ to power on the image.

3. On the guest operating system,
perform the following:

a. Go to Control Panel > AutoPlay.

b. Select Install or run program
from your media from the
Software and games drop-down
menu.

c. Click Save.

d. Open the Local Group Policy
Editor.

e. Go to Computer Configuration >
Administrative Templates >
Windows Components >
AutoPlay Policies.

f.  Select Not configured to disable
AutoPlay.
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Sample Logs

Preparation successful. Missing app detected.

Trend Micro(TM) Virtual Analyzer Image Preparation Tool

Detailed Log

Result
Completed
Virtual machine name

2. Hardware settings
Processor count
Memory size
Large Page

CPU Execution Cap
PAE/NX
SynthCPU

ACPI

HPET

I/0 APIC
Chipset

Use

USB ECHI

VT-x

Porting Device
NIC

NAT Network

IDE Controller
CD/DVD drive
VMDK/VDI

NIC

3. Windows and applications

Windows

Microsoft Office
NET

Internet Explorer
Adobe Flash
Adobe Reader

Preparation successful
2016-87-12 09:47:46
En_win7splen_offices_noab_x64 TL(in VirtualBox) -OK

"usbtablet"
“natnetwork"”
"NatNetwork"

Microsoft Windows 7 Professional SP1 Build 76@1 64bit -OK
0Office 2003_2087 -0K
.NET Framework 4 -0K
Internet Explorer 9.0.8112.16421 -0K
Adobe Flash Player Active X 9.8 -0K
Adobe Reader 8_9 11 -0K
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Preparation unsuccessful. Some items must be fixed manually.

Trend Micro(TM) Virtual Analyzer Image Preparation Tool
Detailed Log

Preparation unsuccessful. Some items need to be fixed manually.
Completed 2016-87-11 85:45:43
Virtual machine name En_win7splen_offices_noab_x64_TL(in VirtualBox) -OK

2. Hardware settings
Processor count
Memory size

Large Page

CPU Execution Cap
PAE/NX

SynthCPU

ACPI

HPET

I/0 APIC

Porting Device
NIC

IDE Controller
CD/DVD drive
VMDK/VDI

NIC

3. Windows and applications
windows 7 (64 bit)
Microsoft Office (not checked)
.NET (not checked)
Internet Explorer The AutoRun/AutoPlay feature is required to run the tool. Log on to the
image as an Administrator to enable this feature. -Requires manual fix
Adobe Flash (not checked) -0K
Adobe Reader (not checked) -0K
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